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Getting Help - Contact Us
Hours - Our normal work hours are 8:00 A.M. to 5:00 P.M. Mountain Time, Monday through Friday.
However if you have a problem, please try at any time, we may be in.
By Telephone - Telephone: (719) 578-9391

Toll Free (US Only): 1-800-391-9391

By Email - help@b3pe.com

By Website - www.b3pe.com

Hardware/Software Requirements
StationManager will operate on any personal computer (PC) configured to run the Windows XP or newer
operating system, through Windows 10. The StationManager software will require a minimum of 110 MB
of free hard disk space when installed with full documentation. Each station will require approximately 19
KB of free hard disk space.

Installing StationManager
An appropriate version of Windows must be running in order to install StationManager. If it is not, start
Windows now. Depending on the format that the software was received in, proceed with one of the
installation options described.
Note...

On Windows Vista or newer machines, you will need to be logged on as the Full Administrator
or use the “Run as administrator” option when executing the installation file.

Installation From A CD
! Place the CD in the appropriate disk drive.
For Windows XP, Vista, 7:
• If the AutoPlay screen is displayed, select the “Open folder to view files” item. Double-click the
setup.exe file. If the User Account Control screen is displayed, select the Yes command button to
proceed.
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• If the AutoPlay screen is not displayed, select the Start button on the Windows Task Bar. Select
the Run item from the Start menu list or on Windows 7 click in the File Search prompt. Type the
letter corresponding to the drive containing the setup CD, followed by “setup.exe”, then press the
Enter key. For example, type d:setup.exe, then press the Enter key or select the OK command button
to proceed.
For Windows 8:
• Switch to the Windows 8 desktop.
• If a notification appears on the desktop, click the notification. Select to open the folder. If a
notification does not appear, a window displaying the disk contents should automatically appear.
Double-click the setup.exe file. If the User Account Control screen is displayed, select the Yes
command button to proceed.
• If the disk contents are not automatically displayed, right-click the mouse pointer in the lower-left
corner of the desktop. Select the Run item from the menu list. Type the letter corresponding to the
drive containing the setup CD, followed by “setup.exe”, then press the Enter key. For example, type
d:setup.exe, then press the Enter key or select the OK command button. If the User Account Control
screen is displayed, select the Yes command button to proceed.
For Windows 10:
• If the File Explorer screen is displayed, double-click the setup.exe file. If the User Account Control
screen is displayed, select the Yes command button to proceed.
• If the File Explorer screen is not displayed, select the Windows/Start button on the Windows Task
Bar. Select the File Explorer item from the Start menu list. The File Explorer screen will be
displayed. Double-click the setup.exe file. If the User Account Control screen is displayed, select
the Yes command button to proceed.
! After completing the appropriate steps from above, the main setup screen will be displayed. Proceed by
following the General Installation Instructions described later.

Installation From An Electronically Received File
Note...

In the following steps it is assumed that the “setup” file containing the StationManager software
has already been downloaded to your machine. If it has not been downloaded, follow the
instructions that were provided at the time of purchase.
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! Find the location where the downloaded folder is saved on your machine. Open the folder using Windows
File Explorer.
! Double-click on the executable setup file contained in the compressed folder. If a Windows Security
warning appears, allow your machine to install the file.
! The main setup screen will be displayed. Proceed by following the General Installation Instructions
described later.

General Installation Instructions
After the setup program has been started, several screens will be displayed during the installation process.
Read the contents of each screen carefully and respond appropriately.
Note...

On the License Agreement screen, read the terms of the License carefully and select the “Agree
to” option. If you do not wish to accept the License Agreement, you will not be able to continue
with the installation process.

A message will be displayed when the installation process is complete. The message will indicate whether
the installation was successful or whether it failed. Select the appropriate option to clear the message.

Starting StationManager
Note...

• An appropriate version of Windows must be running before StationManager may be executed.
If Windows is not running, begin its execution now.
• On Windows Vista and newer machines, you will need to be logged on as the Full
Administrator or use the “Run as administrator” option the first time you execute the
StationManager software.

! From the Windows Desktop select the StatMan 2.0 shortcut icon.
! The StationManager software will be started.
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• Some versions of StationManager will require the software to be registered. If your version
does, the Registration screen will be displayed upon the first execution of the software. The
Registration screen displays the unique Serial Number associated with your license and will
prompt you to enter the unique Registration Number. To request the Registration Number, either
select the Request Registration Number command button, or manually request the registration
number by sending an email (please include your Company Name and the Serial Number) to
registration@b3pe.com. Once you have received the Registration Number, enter the number at
the prompt, then select the Continue command button. You will not be able to fully use the
software until it has been registered.
• If you need to enter the registration number at a later time, select the Cancel command button
to close the Registration screen. After you have received the Registration Number, restart
StationManager and enter the number at the prompt.

! After the software has been loaded into memory, the
StationManager Welcome screen will be displayed. Select the
Continue command button.
Depending on the preference settings, a blank screen may be
displayed, or the last opened database will be displayed. In either
case choose the desired option from the pull-down menus.
Once installed, to become acquainted with the features of the
StationManager software, we suggest that you work the example
described in the Demonstration Guide. If installed, the
Demonstration Guide and other documentation can be viewed and
printed from the Help menu list.

User Count
The number of Users that can simultaneously run the StationManager software is dependent on the license
style purchased. This number is referred to as the User Count. A Single-User License allows only one User
at a time. An Unlimited User License allows an unlimited number of Users.
When StationManager is executed, it checks the number of Users currently using the software. If the User
Count is not exceeded, the software will be started. If the User Count is exceeded, a warning message will
be displayed.
If StationManager is abnormally terminated, the User Count may become corrupt and StationManager may
erroneously report the number of current Users. If this occurs, select the Reset User Count menu item from
the Technical Support submenu of the Help menu list.
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Using StationManager
StationManager is designed to be easy and intuitive to use. However, there are a few general concepts that
need to be learned before becoming proficient with the software. There are two ways to get started with
StationManager.
One, the General Information section in this User’s Manual provides an introduction to many of the basic
concepts required to use StationManager. Review this section to obtain general information needed to use
the software.
The other method is to work the example contained in the Demonstration Guide. The guide will introduce
the basic concepts required to create, populate, access, analyze, review, and print a simple example database.
If time is short, we suggest that you start with the Demonstration Guide - then review the contents of the
User’s Manual when more time is available.

Database Design
The StationManager software provides the User with a comprehensive predefined database for maintaining
design, operation, inspection, and compliance data associated with pressure reducing stations. Data is
accessed through an easy to use spreadsheet style interface. The spreadsheet interface is enhanced by several
complimentary interface options.
! A pop-up Data Entry Form allows “fill-in-the-blank” access and entry.
! A pop-up Audit Report allows view only access to station and compliance data and results.
! A powerful pop-up Schematic Data Interface allows graphical viewing of data values and results,
and point and click access to the station data.
Integral to the database is a full calculation engine for performing capacity and pressure calculations to
ensure regulatory and operational compliance.
The StationManager database consists of a group of files containing various values associated with different
aspects of the station data. These include a file containing general database setup and default information,
a file containing general station information, a file containing the data required for the hydraulic analysis,
a file containing inspection results, and a file containing specific equipment information for the pressure
regulating and relief devices. The Station Data file contains a record for each station. Each station record is
linked to remaining data files, so that all data can be accessed based on the selected station record.
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StationManager defines a station as a collection of runs, stages, devices, and piping sections. A run consists
of one or more stages. A stage consists of one or more devices and the associated piping sections. A device
is a pressure limiting or overpressure device - regulator or relief valve. Devices are designated as upstream
(regulator) or downstream (regulator or relief valve). The piping sections are defined as upstream (supply
or inlet), intermediate (between the upstream and downstream device), downstream (outlet of station), and
stack (outlet of relief valve).
A station can contain one or two runs. A run can contain one or two stages. A stage can contain one or two
devices. Stages can be configured as regulator only, regulator-regulator, regulator-relief valve, dual regulatorrelief valve, or relief valve only. Operation schemes for regulator-regulator configurations can be upstream
monitoring - downstream controlling, upstream working monitor - downstream controlling, or upstream
controlling - downstream monitoring.
When two stages are present, the downstream section of the first (upstream) stage is disabled and the
upstream piping of the second (downstream) stage is assumed to be connected directly to the outlet of the
first stage downstream device.
If a stage consists of a regulator only, the downstream device is disabled. The regulator must be assigned as
the upstream device. The intermediate piping is disabled, and the downstream piping is assumed to be
connected directly to the outlet of the upstream device (regulator).
If a stage consists of a relief valve only, the upstream device is disabled. The relief valve must be assigned
as the downstream device. The intermediate piping is disabled, and the upstream piping is assumed to be
connected directly to the inlet of the downstream device (relief valve).
In addition to the station data, a set of data files referred to as “Property Tables” are also maintained. These
files contain common information about pipe, fitting, regulator, and relief valve properties. The common data
contains values such as inside pipe diameter, equivalent lengths for fittings, and valve factors for the
regulator and relief valves. The Property Tables can be customized by the User to reflect their specific needs.
Some of the supported station configurations are shown in the following figure.
In addition to the configurations shown, relief valves can be “shared” between a parallel run and stage, or
“combined” on stages in series. Sharing a relief valve refers to the case where regulators in a parallel run and
stage are protected by a single relief valve, assumed to be installed on one run or the other. Combining a
relief valve refers to the case where an upstream regulator is protected by two (different) downstream relief
valves - the capacity of the relief valves is combined during the compliance check. The combined relief
valves are assumed to be installed in series on the same run.
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The device control lines are assumed to be connected as follows:
Control Line Sense Location
Configuration

Device

Sense Location

Regulator Only

Upstream (Control)

Inlet of Downstream Piping

Monitor - Upstream

Upstream (Monitor)

Inlet of Downstream Piping

Downstream (Control)

Inlet of Downstream Piping

Upstream (Control)

Inlet of Downstream Piping

Downstream (Monitor)

Inlet of Downstream Piping

Upstream (Control)

Inlet of Intermediate Piping

Upstream (Monitor)

Inlet of Downstream Piping

Downstream (Control)

Inlet of Downstream Piping

Upstream (Regulator)

Inlet of Intermediate Piping

Downstream (Relief Valve)

Outlet of Intermediate Piping

Downstream (Relief Valve)

Outlet of Upstream Piping

Monitor - Downstream

Monitor - Upstream Working

Regulator/Relief Valve

Relief Valve Only

Sample Database
A sample database is included when StationManager is installed. The database contains sample records for
each type of station configuration supported by StationManager. The database will be automatically opened
when StationManager is first executed. To open the database at other times, use the Open menu item from
the File menu list. Instructions for browsing and manipulating the database contents are provided in the
Example section of this Demonstration Guide. If changes are made to the sample database, the original
contents can be restored using the Restore Samples menu item from the File menu list.

Database Interface
The values contained in the database are accessed through a spreadsheet style report. The data is grouped
by functionality into separate report sections which are displayed on separate report tabs. The report consists
of tabs, rows, and columns. Each row represents a record, each column represents a specific data item. Each
station is represented by a record and a set of sub-records for each run and stage.
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Several options are available for viewing and entering data values and results. The primary means of access
is through the Database Report. This access option allows direct access to the data values and results, and
provides a variety of data manipulation tools. The Report interface is complimented by several additional
specialized interfaces. The pop-up Data Form allows data to be entered using a fill-in-the-blank style
interface, and the results are presented in a similar style. The pop-up Audit Form allows view-only access
to station and compliance data. The pop-up Schematic Data Interface provides graphical access to the data
values and results, and allows point and click data editing and graphical display of the calculation results.
The Station Data Report is the only access option which allows station records to be inserted or deleted.
Records can be added to the end of the database with any of the edit enabled interfaces. The report must be
open to access the station data or any of the other data access interfaces. Tools are provided to create
selection and sorted sets, limit the data displayed, to add, enter, insert and move records, to update values
en masse based on a User defined selection criteria, and to save a selected set of data.

Using The Menus
The various routines and features associated with the StationManager software are accessed through pulldown menus. The menus are grouped under headings by functionality. The menu headings are displayed near
the top of the main StationManager screen.
Menu items are accessed by selecting an item from a menu list. The menu lists are activated by selecting the
appropriate menu heading. Menu headings and menu items may be selected by clicking on the menu heading
or menu item. A menu list may be deactivated by pressing the Esc key or selecting another menu heading.
Some menu items have submenus associated with them, these are accessed through submenu “headers”.
Submenu headers are followed by “...” and a “right arrow” symbol. Rest or click the mouse on the header
title to access the submenu. Multiple submenus may exist.

Negotiating The Screens
StationManager provides numerous data screens for entering, editing, viewing, and managing the data it
requires. Generally, a data screen will contain various controls including data fields for entering individual
data values, drop-down lists for selecting predefined data, option buttons and check-boxes for selecting
specific options, data tabs for displaying specific data groups, and command buttons and icons for executing
various functions. The Tab or Enter keys, or the mouse may be used to move between the controls contained
on all screens.
Calculated Value - Display panels highlighted with a yellow background color represent calculated data
values. They cannot be directly edited by the User. The calculated values may change when one of the
editable values are changed and a calculation is successfully executed.
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Checkbox - Options may be presented using checkboxes. Where a checkbox is displayed, a check mark (T)
will appear in the box when the option is selected. The status of the checkbox may be changed by clicking
in the box, or by pressing the Space Bar while the cursor is in the checkbox.
Command Button - A control “button” used to execute a routine or command. Command buttons appear
on data screens, reports, and messages.
Data Field - Data fields are provided for items where the value must be entered by typing. To enter a value
in a data field, position the cursor in the appropriate data field, and type the desired value. When entering
numbers in a data field, do not include the digit grouping identifier (thousands identifier). For example, enter
ten thousand as “10000.00” not as “10,000.00”.
Data Tab - Data items may be grouped and displayed on data tabs. To access the data contained on a data
tab, either click on the tab’s heading, use the Arrow keys when the tab heading is highlighted, or hold down
the Alt key while pressing the key associated with the underlined letter displayed in the tab’s heading.
Drop-Down List - A list used to display and select certain data items. For example, dimensional units are
associated with a drop-down list of available values. To activate a drop-down data list, click on the list or
on the arrow symbol. Select an item from the list by clicking on the desired item.
Icon - An icon is a small image which represents either a routine or a GDI Command. Icons can only be
selected using the mouse. An example of an icon, is the printer icon found on many of the report screens.
Option Button - “Either-or” options are presented using an option button. When option buttons are used,
a dot inside the option circle indicates that the option is selected. Option buttons are usually found in groups.
Only one option may be selected at a time. To change the status of an option button, click in the desired
option circle, or use the Arrow keys to move between the options.
Scroll Bar - The horizontal scroll bar (the bar directly beneath the viewing screen) is used to move the screen
right and left. The screen contents may be wider than the display window, and the horizontal scroll bar allows
viewing of the off-display portions of the screen. The vertical scroll bar (the bar directly to the right of the
viewing screen) is used to move up and down in the screen. The vertical bar allows the screen to be browsed
by adjusting the bar’s slider. The scroll bars may be adjusted by moving the bar’s “slider” with the mouse,
or by clicking on the arrow symbols associated with the specific bar. Large changes in the display can be
made by clicking on the desired bar, either before or after the slider’s position.
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Executing Commands & Functions
Many screens and message contain command buttons. These buttons may be used to access a specific
function or to perform a specific action. The Close or Cancel command buttons found on many of the data
screens are examples of command buttons. When a command button is selected, the function associated with
that command button is executed. Command buttons may be selected by one of the following methods:
! Click on the command button using the left mouse button.
! Use the Tab key to position the cursor on the desired command button, then press the Enter key.
! Press and hold down the Alt key while pressing the key corresponding to the underlined letter of
the desired command button.

Notes On Dimensional Units
When StationManager first starts, its default dimensional units are set to standard US values (Feet, Inches,
Psi, Fahrenheit).
To change the default dimensional units, use the Default Data Values screen found from the Set Default
Values menu item in the Utilities menu list. Select the Dimensional Units tab to access the currently selected
dimensional units. Make any changes by selecting the desired item from the associated lists. Select the Apply
Dimensional Units Only command button to change the values used in the current database. Note - Do not
select the Apply All Values command button unless you are certain that you want to apply all of the default
setting values, on the various data tabs, to the current database.
As used in StationManager, unless otherwise specified, all pressure units represent “gauge” units. Within
the documentation, gauge pressure units are generally shown without a suffix, absolute pressure units are
shown with an “a” or “(Abs)” suffix. Gas volume values or volumetric flow rates are expressed in “standard”
cubic units, based on (adjusted to) the specified base pressure and temperature.

Notes For International Users
StationManager attempts to accommodate the needs of International Users by providing a robust set of
dimensional units. These units can be selected as appropriate for the User’s particular needs.
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StationManager does have a particular weakness when it comes to the various Property Tables that contain
predefined data. These lists are primarily oriented towards US manufacturers and sizes. These tables can be
easily modified by the User to more specifically meet the particular needs of each User. The tables provided
with the software are intended to provide a starting point to allow the User to create their own custom tables.
Note...

The example database provided with StationManager uses US units of measure. To obtain valid
results, these examples must be worked using the US units. When working these examples, if the
default data values and dimensional units have been changed, they must be reset to their original
US values before working with the example database.

StationManager can accommodate either a comma (,) or a dot (.) as the decimal identifier - or a comma (,)
or a dot (.) as the digit grouping identifier depending on the associated Windows setting. For example, ten
thousand and one tenth can be displayed as “10,000.10” or as “10.000,10” depending on the Windows
setting.
Use the Regional and Language options found in the Windows control panel to change the digit grouping
and decimal identification settings.

Uninstalling StationManager
If after using the StationManager software you wish to remove it, select the Uninstall StationManager 2.0
menu item from the StationManager menu list. In Windows 8, right-click on the StationManager 2.0 tile on
the start screen, then select the Uninstall option.
! After the Uninstall Program has been started, read the contents of each screen carefully and respond
appropriately.
Note...

If the Uninstall Program asks to remove any shared system files, select the No command button.

! A message will be displayed when the Uninstall routine is complete. The message will indicate whether
the routine was successful or whether it failed. Select the appropriate option to clear the message.
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On some machines, the Uninstall routine will not be able to remove any directory or file that has
been created after the initial installation.
! Some of the files and/or folders created by StationManager after the installation may include
files in the initialization directory (ini), files in the default database file directory (files), and/or
files in the application directory (app).
! To remove these files and/or folders, use Windows File Explorer to find and delete the
remaining files and folders. An example of the path for the initialization folder is shown below.
The other folders have similar path locations.
• 32-bit machines - C:\Program Files\StatMan 2\ini
• 64-bit machines - C:\Program Files (x86)\StatMan 2\ini

Bradley B Bean PE

ENGINEERING & SOFTWARE
Revision - 005, Copyright 2016, All Rights Reserved.

13

StationManager™ 2.0

Bradley B Bean PE

Getting Started Guide

ENGINEERING & SOFTWARE
Revision - 005, Copyright 2016, All Rights Reserved.

14

